Enter a valid user name and password for an account that has Administration rights in order to view and
update the Retention policies.
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To setup a NEW rule, click the “Add Policy” button, located on the right pane of the Retention
Management window. This will open a Retention properties window.

Enter a name for the new policy you are creating.
Each policy will act on a defined folder or set of folders and document class(s). First, select the
folder(s).
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Next select the Document Class(s) that the policy will act on.

Each Retention Rule will apply to a specific date index value. Use the Index Selection window to choose
the appropriate index to work with. Click on the Index Name and the click “OK” to proceed.
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The policy Type radio buttons give two processing options:
 Review - moves the matching documents to a separate folder that you define in the Move To
window
 Delete – logical deletes the record from the FileNexus database
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Review

Click on a Folder name in the Folder Selection window, then click “OK”.
Delete

302

Finally, check or uncheck the Enabled and Audit Index Information check boxes as appropriate.

Enabled – when checked, the retention policy is active
Audit Index Information – when checked, this will create an audit log record for each record that fits the
defined criteria for the policy. The Audit log will show that the document was moved to a new folder.

Click “OK” and the retention policy is set up.
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Retention Policy Options

To review, update or execute a retention policy, select a policy from the Management window and right
click to get an options menu. The available actions are:
Clone – Copies the selected retention policy into a new policy entry with the same settings
Delete – this will remove the policy
Properties – this will allow you to review and update the policy settings
Run – this will manually execute the retention policy

Select Properties on policy Test2 to see the set up options:

In this example, policy Test2 is set up and enabled. When executed, it will search for all “Policy Docs Email” and “Policy Docs – Word 2007” documents contained in the “Policy Docs” and “Worksheet
Archive” folders. When the Event_Date index value is less than or equal to the current date, the
document will be moved to the Recycler folder. An audit trail record will be created to show the
document move.
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By default the Enabled Retention Policies are executed once per day during off hours. Individual
policies can be executed manually on an as needed basis.
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Deleting Documents
When a Retention Policy is configured to delete the matching documents, the document entry is
removed from the database which makes the document inaccessible under the normal search criteria.
The physical document still resides in the archive however.
In order to physically delete the document as well, change the settings through Archive Management.
For any archive session that you may want the documents physically deleted, select the Properties and
check the Allow Delete from Archive box. You will also need to be sure to create a new Archive file
that will carry the .fdar extension. This represents an archive file that will have data “deleted”.
Note that deleting these documents from the archive file will not free up any disk space. Instead, the
disk space utilized by that document image is overwritten with binary 0’s.

Click “OK” and restart the archive session.
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Register Server

Overview
If you choose to install FileNexus Management tools on a machine that is not the
FileNexus Server, you will need to register the server on the workstation. If you rightclick on the FileNexus Management icon, select Register Server.

When the window appears, enter the name of the FileNexus Server in the Computer
Name edit box, or the IP address of the FileNexus Server you wish to manage and hit OK.
If you only use the FileNexus Management tools on the same server that FileNexus resides
on, you will not need to register the server.
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Starting, Stopping and Pausing FileNexus

Starting, Stopping, and Pausing FileNexus
At times you will need to start, stop or pause FileNexus. The simplest way to perform
these tasks is to right-click on the FileNexus Management icon in your system tray and
select the appropriate option.
Caution: Before you "Close" the "FileNexus Manager" you should always stop the FileNexus
Server.

Closing the FileNexus Manager alone will NOT stop any FileNexus archive or capture
sessions.
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FileNexus File Transfer Program

FileNexus File Transfer Program
The FileNexus Transfer Program was designed to transfer documents to the FileNexus
server without creating any shares on the server. Another benefit of using the
FileNexus Transfer Program is that there is no user intervention needed to transfer
documents.
To start the program, click on the FileNexus File Transfer Program (FTP) icon located
in the FileNexus folder.

After you have started the application, a window will appear like the one below.

To create a new FTP session, you will need to click on the File menu and click on the
New icon or select New from the File menu.

A Session Name dialog will open similar to the one below.
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Rename the session to something that is meaningful so that if you have several
sessions running, you will be able to distinguish between the functions of each session
more easily and make changes if necessary. After selecting a session name, hit OK.
After you have clicked the OK button, the Transfer Settings window will appear.

Source Path
The location of the files to be transferred.
Rename Transferred Files
Renames the files after they have been transferred ensuring unique file names in the
destination folder.
Auto Start
Automatically starts the FileNexus Transfer Program session after the PC has been
started.
Transfer Script Files Last
If you are transferring both the data (.tiff, .pdf, .txt, etc.) file and the script file
(.NXS) to the FileNexus Server, you should transfer the .NXS script file last. This is to
prevent any FileNexus processes running that monitor the destination folder for the
files from complaining that the data file associated with an .NXS cannot be found.
Create Script File
If this option is selected when the FTP Session transfers a file, an .NXS file will be
automatically created to accompany the data file. This may be helpful if the indexes
for the data file need to be updated through the use of a custom VB Script running
through a Preprocessor or Archive Session on the FileNexus Server.
Transfer To Server
Select this option if you do not wish to set up a share on the FileNexus Server as the
destination folder for transferred documents.
Server Name or IP Address
Enter the Server Computer Name or IP Address of your FileNexus Server.
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User Name
Enter a FileNexus user name.
Password
Enter the user’s FileNexus password.
Description
By entering a “description” in the provided edit box, the FTP Session will push the
documents to a predefined path on the FileNexus Server. A FileNexus Administrator
can set up the path on the FileNexus Server that corresponds to the Description value
on the FileNexus Server. For more information on how to set up a Description Path,
refer to the Description Paths section under FileNexus Server Properties.
Transfer To Path
This option can be selected if you do not wish to use the Transfer to Server option. If
you use this option, then the files will be transferred to the path specified. You may
need to create a share on the FileNexus Server if you employ this method of transfer.
Starting and Stopping the FTP program

Starting and Stopping the FTP program
Once you have created an FTP session, it will be necessary to be able to start and/or
stop it.
Starting
To start the session, simply highlight the session name and click on the green arrow to
start it. Or, you can right-click the session name and select the Start option from the
pop-up menu.

Stopping
To stop the session, simply highlight the session name and click on the red stop sign.
Or, you can right-click the session name and select the Stop option from the pop-up
menu.
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FileNexus Image Indexer

Overview
After you have scanned in one or more batches of documents, you can use the FileNexus
Image Indexer to enter index values to documents and prepare them for archival. The
benefit of using the FileNexus Image Indexer is that you can index documents that were
scanned with or without barcode separators. Also, when you are inputting index values,
the Indexer shows only the relevant portions of the scanned image. This application is an
efficient and fast method of adding manual indexes to scanned documents.
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Image Indexer Setup

Indexer Setup
To index documents that were scanned in the FileNexus Scan Station program or
somehow produced by a FileNexus application, start the FileNexus Image Indexer
program by going to Start  Programs  FileNexus  FileNexus Image Indexer.

If this is the first time that you are using the Indexer, select Settings from the View
menu as shown in the above image. The Indexing Settings window will appear.
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Paths Tab

Document Path
The document path refers to the directory on your network that contains images waiting
to be indexed. When you start the Indexer, it will look in this directory for available
image files (Tiff files). If the Indexer finds any image files, it will display them to you
and allow you to enter index values for the documents.
Output Path
The output path refers to the directory that FileNexus will move image documents into
after they have been indexed. This is probably a directory that an Archive Session
monitors. When indexed documents are placed into this directory, they will then be
archived into FileNexus.
Index Settings Path
This is the directory which contains the settings (document path, archive path etc.) for
the Image Indexing program.

Properties Tab

Persistent Indexes
Check this box if you want FileNexus to display the index values entered for the previous
document. This can speed up data entry if you have many documents that use the same
or similar index values.
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Prompt on Delete
Check this box if you want FileNexus to display a warning message before it lets you
delete a page.
Index Separated Documents
Check this box if the image files you are indexing have been scanned in as separated
documents. Alternatively, you can let the Image Indexer know what type of files are
going to be indexed by setting the Document Mode by selecting Separated or
Unseparated from the pull-down menu.

Document Mode
Separated
Use this mode to index documents that were batch scanned using barcode
separators. When you index these documents, the FileNexus Image Indexer will
display only the first page of each document. It's a good idea to use barcode
separators when you are batch scanning long (multi-page) documents.
Unseparated
Use this mode for documents that were batch scanned without using barcode
separators. When you index these documents, the FileNexus Image Indexer will
show you every single page in a document. If you leave all index values the same,
FileNexus will assume that you are viewing a page of the same multi-page
document. If you change any of the index values, FileNexus will consider the
current page as the first page of the next document.
Auto Completion
If you check this option, FileNexus will record index entries and when an index is filled in
that was previously entered on another document, FileNexus will auto-populate other
index values based on a lookup into its own record log. For example, if you enter a
Vendor ID index, if this Vendor ID has been previously entered for another document of
the same document class, the Vendor Name, Address, and other information may
automatically get filled in.
NOTE: This option should only be checked if all of the indexes for a document in a given
document class remain consistent. Do not, for example, check this option if you want to
enter in a Vendor ID to populate only the Vendor Name and wish to fill in other indexes
manually like invoice amount, invoice date, etc.
View All Document Classes
Check this option if you wish to be able to select all of the defined document classes
within FileNexus regardless if all of the documents for a class have been placed in the
Recycle bin (not permanently deleted) because they have been deemed obsolete or
unnecessary by your organization.
316

Script Properties Tab

The Script Properties tab is in place to allow for advanced indexing functionality. There
is a VB Script that can be modified by your organization's developers or customized as a
Professional Service by a Loris developer if you require specific functionality within the
Image Indexing program.
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Using the Image Indexer

Start Indexing

To start indexing documents, click on the green arrow icon as shown above. Once the
indexing process has started, the Indexer will retrieve scanned image files from the
Document Path directory configured in the Indexing  Settings menu.
On the right hand side of the screen, you will see the first page of the image. On the left
data entry boxes and image windows appear for each index for the document class. Any
index that is set up with an input pick-list will appear highlighted in blue, as seen in the
image below for the “Document Type” index.

For highlighted or input pick-list indexes, simply click the drop down and select the
desired input value from the list provided. If the input list does not seem correct,
contact your FileNexus Administrator.
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Changing the Font

If you wish to change the index input font, select Font from the View menu. A dialog
box will appear to allow you to select the font type, style, and size. This will allow you
to change the default Font that FileNexus will use when you are entering Index values. A
larger font may be easier on your eyes if you are indexing a large number of documents.
Edit Menu

From the edit menu, you can delete a page of the current document. By selecting
Delete Page you can specify the page number of the document to start from and the
number of pages to remove, as in the below window.

By default, the Delete Page option will delete the current page of the current document.
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View Menu

You can use the View menu to navigate through pages in the current document by
selecting Next Page or to rotate your document plus or minus 90 degrees, using Rotate
Left or Rotate Right. When you are indexing, it is useful to be able to see the second or
subsequent pages in a document. This way, even if someone scanned the pages out of
order (the second page was scanned first), you will still be able verify the index values on
other pages for data entry. From this menu, you can also select Zoom mode, Select
mode or Pan mode under Band Mode. And as previously mentioned you can also edit
your default input font from the View menu.
Changing the Page View

To change the way the Indexer displays the document on the right hand side of the
screen, right-click on the image. A pop-up menu will appear (as shown above). You can
use the items on this menu to resize and move the image's position on the screen.
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Changing the Index View
Right clicking on the index image will cause a pop-up menu to appear. From this menu,
you can resize the image or change its display properties (grey scale, zoom level, etc.)

To move the image left or right, select the pan mode tool (a hand) from the toolbar.
While in pan mode, your cursor will appear in the shape of a hand (as shown in the image
below). Hold your left mouse button down and the image will move in the same
direction that you move your mouse.

To zoom in on the image, select the Zoom tool from the toolbar (it looks like an open
box). While in Zoom mode, you can zoom in on part of the image by drawing a box
around it. To draw the zoom box, hold your left mouse button down and move your
mouse.

To resize the image box, move your mouse to the edge of the image. When the cursor
changes to a double arrow, you can resize the image box by holding the left mouse
button down and moving your mouse to the left or right.
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FileNexus OCR

OCR Overview
The OCR (optical character recognition) station is used to convert scanned documents
into readable text. In many cases this can reduce or eliminate the need for manually
typing index values. Simply show FileNexus a sample document and highlight the areas
that are to be recognized. Then associate these areas with the appropriate indexes.
Now, when this type of document is scanned in FileNexus, it will automatically "key in"
the appropriate index values for you.
FileNexus is also capable of ICR (intelligent character recognition). ICR is useful for
recognizing hand-printed documents such as loan applications, etc.
With the addition of the OCR module, FileNexus can recognize check marks or X's that
have been placed or written on your document. This is great for multiple choice tests,
surveys, etc.
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Setting up the OCR Station

Setting up the OCR station

From the Indexing Menu, select OCR Settings.

Server Name
This is the name or IP address of your FileNexus server.
Documents to OCR Path
This is the directory that the OCR program will monitor. When it sees documents placed
into this directory, it will attempt to run the OCR program on them. Make sure that you
set your Image Output Directory (in the FileNexus Scanning program) to this directory for
all document classes that you want to OCR.
OCRed Documents Path
After the FileNexus OCR program has indexed your documents, it will place them into
this directory. Generally, this will be the directory that the FileNexus Indexer program
gets its documents from. You can then verify your documents in the Indexer. If you do
not want to perform any verification (not recommended), you can set the OCRed
Documents Path to a directory that is being monitored by the FileNexus Auto Archive
program. This means that your documents will be archived immediately with no
verification.
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Document Zones Path
This directory stores the zone information that you set-up for your different document
classes.
Dump OCR Text to File
Check this box if you want all of the OCR text to be written to a file.
Dumped Text Path
This is the directory that will contain text found in OCRed Zones.
Setting up a Document Class for OCR Indexing

Setting up a Document Class for OCR indexing
1. Start the FileNexus OCR program.
2. From the File Menu, select Open Image to open a sample of your image file.

3. From the Setup Menu, select your document class.
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1. Select the zones that you want to be recognized by using your mouse to draw boxes
around them.

2. When you are setting up zones, the zone closest to the top of the page should be zone
1, the next closest zone should be zone 2, etc. If two or more zones are on the same
line, the zone closer to the right hand side of the page should have a higher zone
number. For example, if zone 3 and zone 4 were both on the same line, zone 4 should be
closer to the right hand side of the page than zone 3. If your zones do not match this
numbering scheme, use the zone reorder button.
To reorder your zones, click on the zone reorder button then click on the zone that
you want to change.
3. Now it's time to associate your zones with the appropriate indexes. From the Setup
menu, select Index Zones.

4. In the Index Zone Assignment window, you will see a list of indexes available for this
document class. Next to each index name is the zone number that it is currently
associated with. To change the zone assigned to an index, highlight the index and then
click on Remove Zone From Index. Now, you will notice that the zone associated with
the index is None. Highlight the index once more, then in the Zone Box, you can change
the zone's number. Click on the Assign Zone To Index button and the current zone
number will be assigned to the highlighted index.
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Dump Zone Text to File
If you want the text in a zone to be written to a text file, check this box. This is useful
when you want FileNexus to "strip" data out of paper based reports and be able to use
the data in other applications (such as spreadsheets, database programs, etc.).
OMR – Optical Mark Recognition
Mark Found – If the OMR engine determines that a mark was in the zone, the value typed
into this box will be placed into your index.
No Mark - If the OMR engine determines that no mark was in the zone, the value typed
into this box will be placed into your index.
In the above example – boxes that are checked will result in YES index values, while
boxes that are unchecked will result in NO index values.
Zone Location
All Pages – If the zone appears on every page, check this box.
Last Page – If the zone only appears on the last page of your documents, then check this
box.
At Page – If the zone appears on a specific page (like page 1), then select this box and
input the appropriate page number.
5. After your zones have been assigned to indexes, click on the OK button.
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OCR Tool Bar

OCR Tool Bar
Setting the zones types
Depress this button for zones that contain flowing text (this is the default setting).
Depress this button for zones that contain tables.
Depress this button for zones that contain images (this setting is not currently used in
FileNexus).
Depress this button for zones that contain regular text, numbers or symbols.
Depress this button for zones that contain text created by a 9-pin dot matrix printer.
Depress this button for OMR (check box) zones.
Depress this button for zones that contain handwriting.
Depress the first button for zones that contain numbers and dots. Select the
second button for zones that contain numbers and dashes.
Manipulating the zones
Click on this button to remove all zones.
Depress this button to reorder your zones. When the button is depressed, you can
click on a zone with your mouse to reorder it.
Manipulating the image
Click on the fit to height button if you want to be able to see both the top and
bottom of your image at once.
Click on the fit to width button if you want to be able to see both the left and right
sides of your image at once.
Click on the rotational buttons to rotate your image.
Click on the gray scale button to toggle between Gray scale and Black & White
modes.
Click on this button to enable or disable the overview window. The overview menu is
useful when you have zoomed and want to know what section of the image you are
looking at without having to zoom out of the image.
Use these buttons to navigate through multi-page documents.
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Starting the OCR Station

Starting the OCR Station
To start the OCR program, select Start OCR indexing from the Indexing menu.

The OCR window will disappear and an OCR icon
will be present in the bottom right
hand corner of your screen. Right-click on the OCR button to stop the OCR process or to
change the OCR settings.

328

FileNexus Scan Station

Scanning Overview
When you have paper documents that need to be archived, you can use the FileNexus
Scan Station application. As documents are fed into a scanner, FileNexus will convert
them into digital images which can be stored to the electronic media of your choice (CD,
hard drive, optical, etc.).
Most of the documents that you scan will be from outside sources. Documents created
in-house (on a computer system) can be electronically archived with the FileNexus PC
Data Module, thereby eliminating the need for printing and scanning. Of course, if your
documents have signatures or handwritten notes, you may want to scan them whether
they were generated in-house or not.
There are 3 steps in the basic scan operation:
1. The scan operator selects the type of document (i.e. the Document Class) that is
being scanned, like Invoices, Packing Slips, Vendor Quotes, etc.
2. The documents are fed into the scanner and scanned.
3. The images are automatically indexed if they contain barcodes and a host system
lookup is conducted by a custom programmed script, or manually indexed using the
FileNexus Image Indexer if they do not.
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Setting up a scanner for the first time

Setting up a scanner for the first time
Step 1
If you have not already done so, install the appropriate Kofax scanner driver. This is the
(VRS) software that accompanies your Kofax card (which probably shipped with your
scanner). If you are not using a Kofax card but instead have your scanner hooked up to a
SCSI card, then you should install the Kofax Adrenaline software.
Step 2
Install any hardware card necessary for your scanner (models 650, 650i, 850, etc.).
Ensure when you reboot your PC that the new hardware is detected and not showing any
device driver conflicts in the Device Manager.
Step 3
Start the Kofax Scan Manager wizard - The icon for the scan manager is found in your
Windows Control Panel and should look similar to the icon below, KSM (32-bit).

Step 4
Follow the instructions in the Kofax wizard. When asked for a source name, try to choose
something descriptive. You can type in any name you want for the source but you should
try to include the make and model number of your scanner and the location of your
scanner. Make sure that you choose a source type that supports image processing if you
want FileNexus to read barcodes and use image enhancement features (deskew,
despeckle, remove lines etc.)

Don't forget to set the scanner as the default source before exiting the KSM Utility.
Step 5
Attach the Scanner to your PC, turn it on, and reboot the PC so that the Scanner is
turned on prior to the PC. (This will help the PC detect the scanner hardware is
available and ready)
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Getting ready to scan

Getting ready to scan
The first step is to launch the Scan Station program. The icon looks similar to the one
below.

Once the application is up and running, the first thing you need to do after you log into
the scan station is to let the FileNexus system know your images will be coming from a
scanner, an image file, etc.

From the main window (shown above), click on the Scanning menu and then Source.
Now you can choose the scanner that you will be using.

After you have selected a scan source from the pull-down menu, click OK.
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After FileNexus has verified that your scanner is ready (i.e. turned on and detected as
ready by the scan station PC), you'll be returned to the main window. However, this
time you should notice that two additional menu buttons are no longer grayed out.

TIP: When you move your mouse cursor over any button, a one line message will appear
at the bottom of your screen describing the button's function.
Now that you have selected your scan source you can:
1. Open an image file containing previously scanned documents by clicking on the Open
icon.
2. Scan a document or group of documents by clicking on the Scan
section on Scanning Documents to be Archived)

icon. (See the

3. Quick scan a page to make sure your scanner is set up correctly by clicking the Quick
Scan icon.

332

Scanning Documents to be Archived

Scanning Documents to be Archived
When preparing to scan documents into FileNexus, be sure to login to the FileNexus Scan
Station program as described in the previous section, Getting ready to scan, and verifying
the scan source.
To begin scanning, you must first click on the green scan icon
the FileNexus Scan Station program.

in the main toolbar of

The Scan Wizard window will open similar to the one below.

In order to scan any documents, you must select the Document Class that describes the
document(s) being scanned. If this is the first time you are using the Scan Wizard, you
will need to hit Add Class to populate the Document Class Name list from where you
must make your selection.
In the Create Custom Class List dialog, highlight the Existing Document Class you wish to
use in the right pane and click the left pointing arrow to add the class to your list. When
finished, hit OK.
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Back on the Document tab of the Scan Wizard, highlight the desired Document Class for
the document(s) being scanned and click on the Paths tab.
NOTE: After selecting the Document Class and editing the settings on the various tabs,
these settings will be saved on the Document Class level, not for every document class.

On the Paths tab, select the directory where you want the scanned images to be
temporarily stored, under Image Output Directory. This is the directory that either the
FileNexus Image Indexer or Auto Archive service will be monitoring. Next, select the
destination folder in the FileNexus Client application in which you want these documents
to be stored by clicking on Select Folder.
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A new window will appear called FileNexus Folder Selection.

Select the desired destination folder and click OK. If you want to create a new folder,
right-click inside the Destination Folder pane and select New Folder from the pop-up
menu. A new folder will be created. To rename this folder, click on its name (New
Folder) once and then type in the new name or right-click on the folder and select
Rename. Click on the OK button when you are finished. After you have finished with the
settings on the Paths tab, click Next or select the Barcodes tab.
If your documents have barcodes on them, you must tell FileNexus which indexes the
barcodes refer to. If you are not using barcodes, make sure the barcode box is not
checked and then click on the NEXT button or select the Separation tab.
To set up one or more of your indexes to get their information from the barcode(s) on
your documents, follow the steps as outlined below.
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Check the BARCODES box. Select the appropriate index. In the example below, the
value of first barcode on the page will be put into the Invoice Number field. To set the
barcode into the Invoice Number index, increase the Barcode Index value to 1, so that
the number 1 appears in the Barcode column next to Invoice Number in the Index Name
column.

Fill in the barcode Mask box if you only want part of the barcode to be used for this
index.
For example:
Barcode
ABC3864T
ABC3864T
ABC3864T
ABC3864T
ABC3864T

Mask
*
XX??*
-X

Result
ABC3864T
AB
C3864T
T

X Include character
? Skip character
- Skip all characters to the right
* Include all characters to the right
Click on the barcode Settings button and fill out the necessary information in the
Barcode Properties window.
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You must have at least one barcode symbology appear in the In Use list box in order for
FileNexus to know what type of barcode to search for. Hit OK when you have finished
entering the barcode information.
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If you are using separator sheets or have a specific number of pages that make up one
complete document then enter the necessary information into the separator dialog box
(shown below). Each time FileNexus encounters a separator page, it will close off the
current document and begin a new document.

Batch Scan
If you want to scan all of your documents first and index them later (in the FileNexus
Image Indexer), or you are scanning documents with barcodes, check this box.
Barcode Page Separator
If you want a specific barcode value (for example 0000) to be recognized as a separator
page, select the Barcode Page Separator radio button and enter the barcode value in the
Barcode Separator Value text box.
Next Barcode Found
If you want FileNexus to start a new document each time it sees a valid barcode, check
this box.
Page Number Separation
If your documents are all the same length, enter in the number of pages each document
will contain in this box. FileNexus will ignore bar codes on all pages except for the first
page of each document. If it does not find a barcode on the first page of a document it
will prompt you to enter in the index value(s) manually. NOTE: Your documents do not
have to contain any barcodes to use this feature. If you know that all of your documents
will be 15 pages long, enter 15 in this box. FileNexus will stop scanning every 15 pages
and ask you to fill in the appropriate index values.
Index Changed
Use this option if you are indexing at the same time as scanning (i.e. you are NOT batch
scanning). FileNexus will display every page for you to manually input index values. As
long as the index values are the same, it will add a page to the current document. As
soon as any index value changes, the page that you are indexing will be considered to be
the first page of a new document.
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No Document Separation
If you do not want to separate your documents, select this option. This option is used
only for Batch Scanning.
Persistent Indexes
If you leave the Persistent Indexes option checked on, FileNexus will carry over any
previous index values onto the pages that follow until a new index is entered or detected
(i.e. barcode).
This is helpful for the following two situations.
1. You are scanning documents with barcodes and only the first page of a multi-page
document contains a barcode. Using this in conjunction with the Batch Scan option
and using Next Barcode Found for page separation automates your scan process and
eliminates the need to manually index documents.
2. You are scanning documents without barcodes and you are not using the Batch Scan
option, so you manually index the first page of a multi-page document during
scanning, and allow the index values to carry over to the pages that follow until you
see the first page of the NEXT document, at which time you change the index value(s)
indicating to FileNexus the beginning of a new document.
If you turn off Persistent Indexes (uncheck this option), index values from the first page
of a multi-page document will not carry over onto the pages that follow.
NOTE: If you are using barcode page separators when scanning, do not check on
Persistent Indexes as your documents will not get separated correctly.
Now it's time for you to let FileNexus know about any special scanner settings that should
be used with this Document Class on the Scanning tab. Click on the Scanner button to
set scanner properties (paper size, orientation, etc). Click on the ADVANCED button to
set-up image processing (deskew, despeckle, etc).

Each side is a page of a duplex scan
Check this box if you are using duplex scanning and you want FileNexus to look at only
the first side of your page for barcodes. If this box is not checked and you are using
barcodes, FileNexus will search both the front and back side of a page for barcodes.
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Page Cache
A higher value in this box can increase scanning speed.
The next tab is the Imaging Tab. If you would like image processing done as your pages
are scanned, enter the necessary information here. Select the type of image processing,
then click the appropriate Modify button. Now you can change the settings for this
particular type of image enhancement. If you wish FileNexus to display documents as
they are scanned then you will be able to choose the scale at which the images will be
displayed on your screen by clicking on the Display button. Of course, at scan time you
can still change the viewing scale.

View Pages
Check this box if you want pages to be displayed on the screen as they are being
scanned. To change the way the pages are displayed (size, etc.), click on the Display
button.
Click on the Next button or select the Finish tab to view a summary of the scan settings
for this Document Class.
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If everything looks acceptable, click on the FINISH button and FileNexus will start
scanning your documents. Please note that once you have scanned documents into a
Document Class, you can no longer go back and add, remove or change indexes for that
Document Class. You can, however, still go back and change scanner settings, barcode
settings, and separator sheet settings.
If you return to scanning the same types of documents at a later date, you will not have
to reset or change the settings on the Paths, Barcodes, Separation, Scanning, Imaging and
Finish Tabs. If you wish to use the same settings as your previous scan of the same type
of document, simply select the Document Class on the Document Tab, then click Scan.
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Quick Scan

Quick Scan
The quick scan function is the fastest way to test your scanner and its settings to make
sure everything is set up correctly. Quick scan can only be selected after you have
selected a scan source. Quick scan will scan one page and then display it on the screen.
Note: Pages scanned in using the quick scan method will not be archived.
To scan a page using Quick Scan:
1. Make sure your scanner is powered on and attached to your computer.
2. Insert a piece of paper into your scanner's document feeder.
3. Click on the quick scan icon or select Quick Scan from the Scanning menu.
After the page has been scanned, it will be displayed on your screen. If you have a
duplex scanner (and FileNexus has been configured to use the duplex option), you will be
able to use the navigational arrows
at the top of the screen to move
between the front and back sides of the scanned image.
Viewing a Scanned Image
On the scan station, after using Quick Scan to scan a page, there are many different
ways to view the scanned image.
Click on the magnifying icons to zoom in on (enlarge) the document or zoom out of
(shrink) the document.
Use the navigational arrows
to move through the document. These arrows
will only be enabled in quick scan mode if you have scanned in a double-sided document
(using a duplex scanner). Otherwise, only 1 page can be viewed in quick scan mode.
Click on the fit to window icon
to have FileNexus resize the document on your
monitor so that you can see both the top and bottom of the document at once.
Click on the display icon
to change the zoom level, rotate the image, etc.
Alternatively, you can click your right mouse button on the image and you will be
presented with the display menu.
Click on the change to zoom mode icon
when you want to magnify only part of the
image. Hold down the left mouse button and then drag a box around the section that
you are interested in. When you release the left mouse button, FileNexus will zoom in on
the selected area.
Click on the change to selection mode icon when you want to draw a zone (rectangle
with your mouse). You can then copy the contents of this zone to the Windows
clipboard.
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Click on the change to pan mode icon
when you want to be able to shift (or pan) the
image. When you are in pan mode, hold down the left mouse button and drag your
mouse in the same direction that you want the image to move.
From the View menu, you can select different levels of zoom and other features. For
more detailed information, please refer to the section View Menu.
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Scanner Properties

Scanner Properties
To change the way your scanner operates with FileNexus, select Properties from the
Scanning menu.

Depending on the make and model of the scanner you are using, you should see a screen
similar to that shown below. Not all features may be enabled for your scanner. Features
that are unavailable will be grayed out.

Source
The source will generally be set for ADF (auto-document feeder) but there may be
occasions when you change this setting to flatbed (when you are scanning a page that
cannot be fed through the feeder such as a page in a book).
Destination
If your scanner has more than one output bin, you can select the bin you want scanned
images to be sent to.
Resolution
The higher the resolution, the clearer the images will be. However, images scanned in at
high resolutions take up more space when they are being archived and scan at a slower
speed. Resolution is measured in dots per inch (DPI). A resolution of 300 DPI is suitable
for most documents.
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Paper Size
Select the paper size from the list that most closely matches the documents that you are
scanning. If you choose a paper size that is larger than your documents, your images will
be surrounded by white space. If you choose a size that is smaller than your documents,
your images will be clipped (part of the document won't be scanned).
Orientation
If you are feeding documents into the scanner top first, choose portrait mode. If you are
feeding documents into the scanner side first, choose landscape mode.
Time-Out
FileNexus waits before issuing an out of paper error message. A normal time out setting
is 10 seconds.
Colour Mode
If your scanner supports colour or gray scale scanning, you can enable it with this option.
Keep in mind that both colour and gray scale images consume much more space than
black and white documents when they are archived and they scan at a slower speed. For
most documents, black and white scanning will meet your needs.
Auto Length Detection
Select this option to have FileNexus determine the appropriate length setting for your
documents.
Continuous Feed
Select this option when you are scanning a very long page. FileNexus supports the
scanning of pages that are up to 9 feet in length.
Manual Start
If your scanner requires a manual start signal, select this option
Sides
Select Single-sided to scan only the front side of a page or select Duplex to scan both the
front and back sides of a page.
Options
Click on the options button to enable or disable scanning area features such as picking
zones, page thresholds, etc. Picking rectangles, when enabled, tell the scanner to scan
only a portion of a page. Page thresholds tell the scanner to disregard any page that is
smaller than a certain number of bytes. This is useful for eliminating blank pages. The
rotation options can be used to have FileNexus rotate images as they are scanned. They
will then be archived in the rotated state. This is useful if you are scanning in a large
number of pages in a landscape format.
Advanced
Click on the advanced button to enable or disable image enhancement functions such as
brightness, contrast, etc. if you are scanning with VRS (Kofax Virtual Rescan image
enhancement).
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File Menu

File Menu
When you first click the File Menu, you will see that there are only four options available.
If you get an error when you try running the application for the first time that says "Kofax
Image controls not installed" then you must go back and install or reinstall the Kofax
image software.

FileNexus Login
Allows you to login as a different user or reconnect to the FileNexus Server if you have
been disconnected for some reason.
Clear
Allows the user to clear the current document on the screen.
Open
Allows the user to open an image file (Tiff image).
Save As
After a user has made changes to an image file, this option allows the user to save the
current file.
Print
Allows the user to print an image file.
Exit
Allows the user to exit the application.
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Edit Menu

Edit Menu
The Edit menu allows you to copy, zoom, and pan a document that has been scanned
using the Quick Scan option. For details on how to scan a document using the Quick Scan
option, refer to the section entitled Quick Scan.
Edit Menu
After you have scanned a document using Quick Scan, the following options will become
available to you in the Edit Menu.

Copy
If you select an area of the document you just scanned in using Quick Scan, choosing
Copy from the Edit menu will copy the information to the Windows clipboard.
Zoom
If you click on Zoom in the Edit menu before you select an area of the current document,
the region of the document you select will enlarge for easier viewing.
Select
By clicking on Select in the Edit menu, you can left-click on the current document and
drag your mouse to select a zone to copy.
Pan
Select Pan from the Edit menu if you wish to be able to pan over the document after it
has been enlarged using the Zoom feature.
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Scanning Menu

Scanning Menu

For detailed information on the items in the scanning menu, refer to the previous
sections on Quick Scan, Properties, Advanced, and Options.
To view the current scanner attached to the FileNexus system, select Scanner from the
Scanning menu. Please note that this option will only display accurate information if
your scanner is hooked up to your computer through a Kofax card. In all other cases it
will display a Bell and Howell scanner.
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View Menu

View Menu
From the View menu, you can select different levels of zoom and other features
pertaining to the currently scanned and displayed document.

Barcodes Found
If you have barcode detection enabled, click on this option to see a list of the barcodes
that FileNexus has detected on the current page. This option is useful when you want to
ensure that your barcode options have been set up correctly.
Display
By selecting Display from the View menu you can rotate the image, select a zoom level,
or change the scaling attributes in the Display Properties dialog.

Scale-to-Gray
This feature is useful for improving the display of images on certain monitors. On
low resolution monitors, some image data is lost causing characters to appear
jagged on the screen. Scale-to-gray compensates for the lost data by replacing
blocks of pixels around the edges of lines and characters with an intensity of gray.
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This enhances the appearance of lines and characters by making them seem
smoother on the screen.
Horizontal Saturation
Check this box to enable horizontal saturation. The saturation feature is useful for
enhancing an image after a scaling operation.
Vertical Saturation
Check this box to enable vertical saturation. The saturation feature is useful for
enhancing an image after a scaling operation.
Fast Scale
This option is no longer used as all scale factors display equally fast under
FileNexus versions 1.2 and higher.
Fit to Width
Resize the current image so both its left and right sides fit on the screen.
Fit to Height
Resize the current image so that it is visible (from top to bottom) on the screen.
Clear
Select this option from the View menu to remove the current image from the screen.
Fit Window
Resize the current image so both sides fit on the screen.
Correct Aspect Ratio
Check this option in the View menu when you want FileNexus to display images that have
horizontal DPIs that are different from their vertical DPIs (such as fax images).
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Imaging Menu

Imaging Menu

Depending on the nature and quality of the documents that you are scanning, you may
want FileNexus to enhance the quality of the scanned images. Refer to the next section
on Image Enhancement Tips if you would like some basic information before you start
adjusting the settings available through the Imaging menu.
Barcode Properties
Select the Barcodes from the Imaging menu to configure what types of barcodes
FileNexus should try to identify on your documents. Be sure to check the Enable box if
you want barcodes to be recognized. Check the Learn box if you want FileNexus to autodetect barcode characteristics (height, width, quality) on documents. NOTE: This
feature does not work with Postnet barcodes.
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Barcode Height
Use this setting to set the height (in inches) of your barcodes. Generally speaking,
the taller your barcodes are, the faster they will be identified.
Barcode Width
Use this setting to set how wide (in inches) your barcodes are.
Any Width
Check this box to have FileNexus search for barcodes that have unknown or varying
widths.
2 to 1 Ratio
Check this box if your barcodes are roughly twice as wide as they are tall. This
will help to speed up barcode recognition.
Search Direction
If all of the barcodes on your documents will be right-side up, select 0 degrees. If
your barcodes are sometimes put on your documents in a different orientation,
then check the appropriate search direction box. The fewer directions that
FileNexus has to search for a barcode, the faster the barcode recognition process
will be.
Type
Highlight the type or barcode symbology that you will be using and then click on
the Add button to add it to the list of barcode types that FileNexus will search for.
The fewer types of barcodes that have to be searched for, the faster the barcode
recognition process will be.
As patch code
Select this option if you want FileNexus to use a barcode as a patch code also.
Patch codes can be used to change scanner settings in the middle of a batch of
documents. Not all scanners support Patch codes.
Minimum Characters in Barcode
By letting FileNexus know the minimum characters that will appear in your
barcodes, you can improve the speed at which barcodes are recognized. FileNexus
will ignore any barcode that has fewer characters than the value you enter in this
box.
Maximum Barcodes Per Page
Allows FileNexus to ignore barcodes in excess of this value and can improve the
speed at which barcodes are recognized.
Maximum Barcodes Per Line
Allows FileNexus to ignore barcodes in excess of this value on a given line and can
improve the speed at which barcodes are recognized.
Quality
If your barcodes are of a poor quality (printed with a dot-matrix printer), selecting
the Poor option will force FileNexus to be even more rigorous in its search for
barcodes. On the other hand, if all of your barcodes are of an excellent quality,
select the Good option and the barcode recognition process will go faster.
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Checksum
If Checksum is enabled FileNexus will treat the last digit in a barcode as a check
digit. If the Checksum is not enabled then FileNexus will treat the last digit in a
barcode as part of the barcode. If Checksum is enabled and a found barcode fails
the checksum test, the barcode will be ignored. Checksum calculations work only
on barcodes that have check digits embedded within them (Code 39, Interleaved 2
of 5, and Linear 2 of 5).
Black Border
Depending on your scanner, you may find that some of your images have a black border
around them. This occurs when the scanner scans an area slightly larger than the actual
page size and the scanner has a black belt or drum. FileNexus can automatically remove
black borders when it is scanning simply by using the Black Border option from the
Imaging menu. In the Black Border Properties window, check the Enable black border
removal box (as shown below). This process replaces black border pixels with white
pixels on an image. Black border removal cleans up the image without changing its height
and width. If you check the Crop option, this process removes black border pixels from
an image. Black border cropping cleans up the image and reduces the height and width
by the size of the black border. The White Noise Gap is the number of white pixels
(noise) that can occur in the black border. If the number of white pixels is greater than
this amount, FileNexus will assume that this is not part of a black border but is instead
part of the image.

Deskew
Sometimes, because of mechanical problems with your scanners, pages will be fed into
the scanner on an angle. FileNexus can identify and correct skewed images by as much
as 12 degrees. Deskewing images can help with OCR and Barcode recognition. Correcting
heavily skewed images can adversely impact performance. Skew calculation requires a
source image that has a horizontal and vertical flow, such as text or lines. A skew
calculation for an image that consists of mostly lines with no horizontal or vertical flow
(a picture for example) can cause an invalid skew angle.
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Be sure to enable both detection and correction if you want FileNexus to fix skewed
images.

Despeckle
Speckles on an image are groups of black pixels surrounded by white pixels (or white
pixels surrounded by black pixels). Often they are referred to as noise. These unwanted
speckles can be removed from your images by enabling FileNexus' despeckle feature.
Once despeckle has been enabled, you must tell FileNexus what the maximum height and
width a speckle can be. If you set these numbers too high, parts of your image (such as
periods, commas, etc.) may be removed. If you set these numbers too low, you may not
remove as many speckles as you would like. Be sure to test this option on several sample
documents (using Quick scan) to make sure that you have acceptable settings.

354

Image Filtering
By selecting Image Filter from the Imaging menu the following window will appear.

Through this window, you can enhance line edges, smooth out characters, and remove
background noise on an image. For example, if the character edges on your image
appear to be choppy and surrounded by extraneous noise, you might use the Character
Smoothing filter to remove some of the noise and smooth out the characters. This will
increase OCR accuracy and reduce the archived file size.
Character Smoothing
This filter smooths characters and lines. It has no negative impact on the image
and is a non-destructive filter. It increases legibility, OCR accuracy and it
consistently reduces archived file sizes by 10-15 percent.
Thinning Filter
This filter thins characters and lines. It can have a negative impact on the image
and its usage should be determined based on the quality of the original images. It
helps with character separation (for elements that are ballooned or blended
together).
Thicken Filter
This filter thickens lines and characters. It may exaggerate background noise.
This is a destructive filter and can have a negative impact on the image. It is good
for enhancing dot-matrix and fax images.
Smooth and Clean
This filter smooths out characters, removes background noise, and may eliminate
lines. It is a destructive filter but usually has a positive impact on the image. It
increases legibility, OCR accuracy and consistently reduces archived file sizes by
10-15 percent. Usage of this filter should be based on the quality of the original
images.
Fill Line Breaks
This filter fills in and smooths lines. It is a destructive filter and can have a
negative impact on images because parallel lines close together may be merged.
This filter may increase legibility but its usage should be determined based on the
nature and quality of the original documents.
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Smooth, Clean and Preserve Horizontal and Vertical lines
This filter is the same as the smooth and clean filter except that is will not remove
horizontal or vertical lines.
Fill Line Breaks and Preserve Horizontal and Vertical Lines
This filter is the same as the Fill Line Breaks filter except that it will preserve
horizontal and vertical lines.
Light Thicken Filter
This filter has the same characteristics as the Thicken Filter (it thickens lines and
characters) except that it is not quite as aggressive as the Thicken Filter.
Outline Filter
This filter extracts an outline of all image elements. It can have a negative impact
on the image and is a destructive filter. Usage should be determined based on
image content.
Line Removal
If your image contains unwanted horizontal and/or vertical lines, you can remove them
with the Line Removal option in the Imaging menu. You can optionally enable character
reconstruction to repair text that intersects lines that are removed.

Horizontal Line removal
Maximum Length
Specifies the minimum length of a horizontal line to remove (measured in pixels).
Set this value to a large enough value so those text objects (such as the horizontal
bar of a capital "T") are not mistaken for horizontal lines. Setting a larger value
also allows FileNexus to work faster because many objects (such as text) can be
ignored when searching for lines.
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Maximum Height
Specifies the maximum height (thickness) of a horizontal line to remove.
Maximum Break
Specifies the maximum size that a run of white speckles in the line can be and still
be considered part of the line. Set the maximum break value to no more than 2 or
3 pixels (at 200 DPI). Doing so will help prevent text characters from being
considered horizontal lines to be removed.
Edge Clean Factor
Speckles (noise) that occur above or below a horizontal line can be cleaned when
the line is removed with this setting.
Vertical Line Removal
Minimum Height
Specifies the minimum height of a vertical line to remove. Set this property to a
large enough value so that text objects (such as the vertical bar in a capital "T")
are not mistaken for vertical lines. Setting a larger value also allows FileNexus to
work faster because many objects (such as text) can be ignored when searching for
vertical lines.
Maximum Width
Specifies the maximum width (thickness) of a vertical line to remove.
Maximum Break
Specifies the maximum size that a run of white speckles in the line can be and still
be considered part of the line. Set this value to a maximum of 2 or 3 pixels (at
200 DPI). Doing so will help prevent text characters from being considered
vertical lines to be removed.
Edge Clean Factor
Specifies cleaning up black noise left on an image left after a vertical line has
been removed.
Horizontal Character Reconstruction
If enabled, horizontal character reconstruction will repair characters after
overlapping horizontal lines have been removed.
Minimum Repair Height
Specifies the minimum height of characters to repair.
Maximum Repair Width
Specifies the maximum width of characters to repair.
Vertical Character Reconstruction
If enabled, vertical character reconstruction will repair characters after
overlapping vertical lines have been removed.
Minimum Repair Height
Specifies the minimum height of characters to repair.
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Maximum Repair Width
Specifies the maximum width of characters to repair.
Streak Removal
Sometimes streaks are included on an image during the scan process. For example, they
might occur as a result of the following:
 Marks on the original page
 Dust in the scanner assembly
 Faulty scanner CCD (camera)
These streaks can be removed with FileNexus' streak removal feature. Simply enable
streak removal and specify the maximum width (in pixels) of streaks to be removed. Any
series of black pixels less than or equal to the streak width will be removed. Streak
removal is generally used to remove vertical streaks. A typical value for the width of
streaks to be removed would be 1 or 2 pixels. Setting this amount any higher might have
an adverse effect on the image by removing image data.
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Image Enhancement Tips

Image Enhancement Tips


Character smoothing always has a positive impact on an image.



Using a combination of removing lines and the smooth and clean filter will produce
better results than just using the smooth and clean filter.



The smooth and clean filter should not be used as an alternative to despeckling
and removing lines from an image.



The combination of despeckling and using the smooth, clean and preserve filter
will produce better results than just using the smooth, clean and preserve filter.



Thinning should only be applied to images that contain elements that are blended
or ballooned together. Applying this filter to images that do not contain such
elements can cause the loss of image data.



Light thicken should only be applied to images that have been deshaded and
despeckled so that background noise will not be exaggerated.



Thicken should only be applied to images that have been deshaded and despeckled
so that background noise will not be exaggerated. Thicken should only be used on
images that contain light or thin elements (such as dot matrix characters or fax
images). Applying this filter to images that do not contain such elements can
cause characters and lines to blend together. Thicken is much more aggressive
than the light thicken filter.



Fill line breaks are recommended for images that contain lines. However, it may
cause parallel lines close together to merge or become blended. For images that
contain parallel lines, use the Fill line breaks and preserve lines filter.
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Configuration Menu

Configuration Menu

The Configuration menu in the FileNexus Scan Station program can provide added
functionality for FileNexus Administrators and added scan controls for end users.
Depending upon how different FileNexus users have been set up, they may have the
ability to change their FileNexus passwords, create Document Classes, or set different
scan options.
Password
By selecting the Password option from the Configuration menu, the Password Dialog will
appear. By default, the user name will be the one currently logged into the scan station
program. If you do not wish to change the displayed user's password, simply hit Cancel.
To change the password for jsmith in the below example, simply enter in the new
password in the Password and Reenter Password edit boxes, and hit OK.

Please refer to the sections that follow to learn about configuring a New Document Class
and setting scan Options.
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New Document Class

New Document Class Dialog
The New Document Class dialog box allows a FileNexus Administrator (or users with
Administrative rights) to create and define a new document class. Unlike the dialog
available in the Data Capture Setup program, this New Document Class dialog will default
to creating a Tiff Image document class as you are creating the class from a Scan Station.
Creating a new Document Class from the Scan Station Program is essentially the same as
creating one from the Data Capture Setup Program. Please refer to the section, Creating
a Document Class for more information.
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Scan Options

Overview
Selecting Options from the Configuration menu allows FileNexus Administrators the
ability configure scan settings for end users in a variety of ways by checking to
appropriate items on the Scan Options dialog.

From the Scan Options dialog, you can choose to import images from a file (if a scanner is
not hooked up to a machine but you have access to previously created Tiff images),
maintain user based scan settings, lock scan settings for users, or have users default to
the last scan settings used.
Refer to the proceeding sections for more information on each scan option.
Import From a File
User Based Scan Settings
Lock Settings for End Users
Save Last Scan Settings as Default
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Import From a File

Import From a File
If you check on the Import From a File option in the Scan Option dialog, this allows a
user that may not have a scanner attached to their PC to process Tiff images and archive
them to FileNexus.

After selecting Import From a File in the Scan Options dialog and hitting OK, you will
need to select and verify your scan source as normal. Under the Scanning menu, select
Source.
NOTE: In order to use the Import From a File option, you must have a virtual scan source
previously set up using the KSM utility located in the Windows Control Panel. For more
information, see the section on Setting up a scanner for the first time.

After you hit OK once you've selected the Virtual Scan source you created in the KSM
utility (Kofax Scan Manager), you can proceed with using the Scan Wizard as normal, as
outlined in the section Scanning Documents to be Archived.
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One of the few differences you'll find when importing from a file rather than scanning in
hard copies of documents is that you will need to specify the Source Path for the Tiff
images to process. Simply proceed to the Paths tab in the Scan Wizard window and
specify the source path as shown in the example below.

When importing from a file, you can still read barcodes, separate documents, and index
files as you would when scanning.
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User Based Scan Settings

User Based Scan Settings
If you select the option for User Based Scan Settings, this allows multiple users to scan
the same types of documents at a scan station, but output the scanned data to different
network directories.

This may prove helpful if each user needs to scan the same types of documents (Invoices,
for example) to different output directories. As a FileNexus Administrator, you may wish
to implement user based scanning to allow for separation of work to later ensure that
users index only the documents they themselves scanned into FileNexus.
To setup user based scanning, a FileNexus Administrator will need to login to the Scan
Station program and select Options from the Configuration menu. Then, check User
Based Scan Settings (as shown above), and ensure Lock Settings for End Users is NOT
checked.
Next, you will need to login to the Scan Station program as each of the scan users to set
which document class(es), output paths, barcodes, imaging, and other settings they will
use when scanning documents.
For user jsmith, in order to scan invoices the paths tab may look like the following
example.
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And the separation method may appear as follows, if not scanning with barcodes.

By having the image output go to a jsmith subdirectory of the Indexer folder, jsmith can
proceed to index only the invoices he scanned in when returning to his PC (assuming it is
setup with the FileNexus Image Indexer program). Similarly, other users that scan
invoices at the same scan station can have their image output go to their own
directories.
After you are satisfied that each scan user has had their own scan settings configured, log
into the Scan Station program to ensure that the output directories (and other settings)
are correct for each different user. Even if you don't have any documents on hand to
scan, be sure to hit the Scan button on the Document tab or Finish on the Finish tab in
order to save the settings for the current user.
Then log back into the Scan Station program as an Administrator to lock the settings for
end users so they cannot alter what has been setup. To lock the settings, please refer to
the next section.
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Lock Settings for End Users

Lock Settings for End Users
When you are logged into the Scan Station program as a FileNexus Administrator, you are
able to lock the scan settings for end users, so they may not alter any paths, barcode,
separation, or other imaging settings when scanning. This may prove helpful if you have
users consistently needing to scan the same type(s) of document(s) each time they scan.
First, you will need to login as each of the scan users (without administrative rights) that
will be using the scan station.
Set the document classes, paths, barcodes, separation and other settings as you would
normally for each user login. Even if you don't have any documents on hand to scan, be
sure to hit the Scan button on the Document tab or Finish on the Finish tab in order to
save the settings for the current user.

Once you have defined the scan settings for each of the scanning end users, log back into
the Scan Station program as a FileNexus Administrator and select Options from the
Configuration menu to view the below Scan Options window.
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Check Lock Settings for End Users and hit OK. Then, verify that the scan settings are
locked for each of your scan end users.
Verifying Settings are Locked
To verify that you have locked the scan settings for your end users, log into the Scan
Station program as each of the scan users and check the scan settings by trying to scan a
document (even if no hard copy of a document is available).
For example, if you have a FileNexus user jsmith, log in with jsmith's password to the
scan program and try to scan a document. You'll notice in the Scan Wizard that jsmith
cannot go to the Paths tab. If you attempt to access ANY tab other than the Document
tab, you will see the following message appear.

In addition, jsmith does not have access to any buttons on the Document tab except for
Scan. The other buttons on the Document tab have been disabled. This way, an
administrator can ensure that once scan settings have been adjusted and tested for a
document class(es), that no other end users can change them.
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Save Last Scan Settings as Default

Save Last Scan Settings as Default
If you select the option of Save Last Scan Settings as Default, this allows scan users to
adjust scan settings when needed, but default to whatever settings were configured the
last time a particular document class was scanned.
This option may prove helpful if you want to grant users the ability to tweak the scan
settings periodically to adjust for different paper quality and optimize scanned image
quality. It may also be helpful if users need the ability to change which document
classes to scan to or change output paths for any reason.

To implement this option, you will need to login as a FileNexus Administrator and select
Options from the Configuration menu. Then check Save Last Scan Settings as Default.
Be sure not to check Lock Settings for End Users as this will prevent users from being
able to change the scan settings at all.
Then each time any user scans documents at the same scan station, the settings will
default to the settings used for the most recent scan.
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Log Settings

Log Settings
As a FileNexus Administrator, you might find it helpful to log the settings for a particular
scan station. In order to configure logging for a scan station, you must first login to the
Scan Station program as an administrator, select Options from the Configuration menu,
and click on the Log Settings button.

After you click on the Log Settings button, the following window will appear.

Log File Name
This is the path to the scan log file. The file must have the file extension ".log".
Maximum Log Size
You can specify the maximum log file size in MB by entering it in the text area next to
Maximum Log Size: or by using the up and down arrows to increase or decrease the size
in MB.
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Circular Log
Check this option if you want the log file to be overwritten and start again once it
reaches the specified maximum log size.
Create New Log File
Click on the appropriate radio button to choose how/when you wish a new log file to be
created. Check Daily if you want a new file every day, Weekly for once a week, Monthly
for once a month, or Maximum Size to wait until the log file reaches the specified
maximum log size.
Delete the Old Log File
Check this option if you want the old log file for archive sessions to be deleted when a
new one is created.
Move Old Files to:
Instead of deleting old log files, you can specify a valid network path to have the old log
files moved to for long term storage.
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FileNexus Script Editor

Overview
The FileNexus Script Editor is a utility that allows you to open and edit FileNexus created
script files (files with a .NXS extension). The Script Editor is a tool designed to make
viewing and editing a .NXS file much easier. Prior to the "Script Editor", if you needed to
view or change a .NXS file, you would need to locate the proper script file and edit it in
an application like Notepad.
Launching the Script Editor
Script Editor Options
Using the Script Editor
Script Properties
Viewing the Document
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Launching the Script editor

Launching the Script editor
With the new "Script Editor" tool, all you need to do to view or change a .NXS file is
launch the FileNexus Script Editor from your Windows Start menu as shown ...
Start  All Programs  FileNexus 
or double click on an .NXS file.
If you launch the Script Editor from the Windows Start menu, you can open a specific
.NXS file by selecting Open from the File menu or clicking on the Open icon
in the
toolbar and browsing to the .NXS file.

Once you have opened a specific .NXS file, you will be able to view the indexes available
for the document.
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Whether you have double-clicked on an .NXS file to launch the Script Editor or you have
launched it from the Windows Start menu, in order to edit any of the index values in the
.NXS, you must login to FileNexus by selecting FileNexus Login from the File menu.

You can then proceed to edit index values by entering the correct values in the edit
boxes provided. Be sure to save your changes before exiting the Script Editor.
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Script Editor Options

Script Editor Options
There are several editor options that should be known before you start using the Script
Editor. You can access the Script Editor's Options window by selecting Options from the
View menu.

Prompt To Overwrite Files
If this option is selected, then anytime you use the "Save As" option in the Script editor
and you select a file in a folder that already exists, FileNexus will prompt you to
overwrite the file.
Rename Document File
If this option is NOT selected, then every time a user saves a .NXS script file, the original
document name will not change.
Move Script to Save as Location
This option will move the current .NXS script file (not copy) to the "Save As" location.
Move Document File
This option will move the "Document File" (not copy) to the "Save As" location.
Display Login Dialog When Started
This option will force the user to login every time the Script Editor is started.
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Using the Script Editor

Using the Script Editor
When using the Script Editor, you can elect to open more than one .NXS file at a time.
The various opened script files will then appear as separate tabs in the Editor as shown
below. You can then select the script you wish to view/edit by selecting the appropriate
tab.

To edit an index value, you may need to login if you have not already done so. Select
FileNexus Login from the File menu, and log in as you normally would for any FileNexus
application. You will then be able to click in the edit box to the right of an index name
and update its value.
To save your changes, you can click on the save icon , or you can close the Script Editor
window in which case you will be prompted by a message box similar to the one below to
save your changes.

376

The Script Editor Toolbar should appear at the top similar to this:
Creating a New Script
You can create a new .NXS file by clicking on this icon. You will then need to select a
destination folder in FileNexus for the document from the top pane of the below window
and then document class in the Class Name pane of the below window. Then click on
OK.

The new script file will appear in the Script Editor as a new tab, complete with the
indexes available to the document class selected from the previous window. Once you
have entered all the necessary data in the index fields, you must select Save or Save As.
If you have selected the Save option, there will be a new file generated with a .NXS
extension and both files will be saved as the new name. If you have selected the Save
As option, then a new .NXS file will be created and a copy of the original file will be
created in the new folder. The original file will remain the name it was in the folder it
was in.
Opening a Script File
Clicking this icon will allow you to open an existing .NXS file to view/edit.

377

Saving Changes
Clicking this icon will automatically save any changes you have made to the currently
selected .NXS file.
Script Properties
See the section on Script Properties.
Viewing the document
See the section on Viewing the document.
Help
This will launch the FileNexus Help file and open to the page on the FileNexus Script
Editor.
Script Properties

Script Properties
The Script Properties window has two tabs; the Properties tab and the Advanced tab.
Properties Tab
The Properties tab allows you to view the Compression, number of Document Pages, and
Separation Status.

Compression
You can choose None, ASCII or Binary compression. By default, None is selected for most
documents.
Document Pages
Here you can view/edit the number of pages a document contains.
Separation Status
This is helpful to know if you will be manually indexing the document using the FileNexus
Image Indexer program. In the Indexer program, you will have to select either Separated
or Unseparated before you begin to index documents.
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Advanced Tab
The Advanced tab allows you to add variables to the script that may be used by a custom
VB script when archiving the document. For more information on how to employ the
variables in the Advanced tab, contact the support desk at Loris Technologies.

Viewing the Document

Viewing the Document
At times you may need to verify that you have selected the correct document or perhaps
you would like to view the document to verify the index values. To view a document,
click on the correct .NXS file tab in the Script Editor.

Then select View Document from the View menu or click on the View Document icon .
After you have clicked on the View Document icon, the document will open up in its own
default viewing window.
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FileNexus Spool Grabber and Capture Utility

FileNexus Spool Capture Utility
The FileNexus spool capture utility is composed of three separate programs:
1. The Spool Grabber application.
This program runs on a client PC and monitors the Window's spool directory. Anytime
an application prints to the FileNexus printer (see the following section for
instructions on setting up the FileNexus printer), the Spool Grabber program extracts
the data from the file and puts it into a .tif image for identification by the FileNexus
server.
2. The Spool Capture Service runs on the FileNexus server. When .tif files are sent
from one or more Spool Grabber programs (running on client PC's), the Spool Capture
program reads through the text embedded within the image file and tries to identify
the document. The results are turned into multi-page .tif images paired with script
files (.NXS) which can then be archived by FileNexus.
3. The FileNexus PDF Print application (may or may not be needed at your site) is used
when you have many PDF documents that you want to archive to FileNexus. Instead
of printing the files individually from a client PC, you can instead send all of the PDF
files to a directory that is being monitored by the FileNexus PDF print application.
This application will launch Adobe Acrobat and print each PDF document in the
monitored directory to the FileNexus printer. The Spool Grabber program will then
send the documents to the server as normal.
NOTE: Although the FileNexus Spool Grabber can be configured to automate the printing
of files in a designated directory, some applications like a PDF viewer may not exit after
printing the document.
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Installing the FileNexus Spool Grabber Program

Installing the FileNexus Spool Grabber Program
When installing FileNexus onto a client PC (using the FileNexus installation CD), be sure
to select custom install. Then, from the options list (as shown below) be sure to select
Spool Grabber as a program that will be installed.
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Creating a FileNexus Printer
The Spool Grabber program will monitor one printer on your client PC. Documents sent to
this printer will then be archived to FileNexus. Since you will probably also want to print
documents on your client PC the best idea is to create a new printer that will be used
only for archiving documents.
To do this, add a new printer (through the Window's control panel) and select the HP
LaserJet Series II printer driver. Make sure the printer is installed as a local printer (not a
network printer), and that it is set to spool documents using an EMF (enhanced meta file)
format. Also ensure that "Keep printed documents" is checked on.

Since documents will never actually "print" to this printer or its port you can select any
port for it that you have available like LPT1 even though you also have a "real" printer on
LPT1.
Next, set the printer to Pause Printing – this means documents sent to this printer will go
to the Window's spool directory but they will not be printed. The spool grabber program
will then remove them from the spool directory and send them to the FileNexus server.
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Spool Grabber Setup

Spool Grabber Setup
To run the Spool Grabber program, launch it from the Windows Start menu. You will
notice a new print icon in your Window's taskbar.
Right-click on the icon to display the
following menu.

Options
Allows you to change spool grabber settings (i.e. the server to connect to, printer to
monitor, etc.)
Auto Start
If this item has a check beside it, the Spool Grabber program will immediately start
grabbing files from the appropriate spool directory when the program is launched. If
there is no check beside this item, after running the program you have to click on the
Start Spool Grabber menu item before the Spool Grabber will actually begin processing
files.

383

Animated
If this item is checked the spool grabber icon (in the Windows system tray) will be
animated when the Spool Grabber program is on. If the Spool Grabber program has not
been started, then the icon will not be animated.
Start Spool Grabber
Clicking on this menu item will instruct the Spool Grabber program to begin processing
files.
Stop Spool Grabber
Clicking on this menu item will stop the Spool Grabber from monitoring the spool
directory and processing files.
About
Displays current version information.
Close
Closes (and stops) the spool grabber program.
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Spool Grabber Options

Spool Grabber Options

User Name
Your FileNexus login username that the Spool Grabber will use to make its connection to
the FileNexus server.
Password
Your FileNexus password or network password if you are using Active Directory
authentication.
FileNexus Server Name
The name (or IP address) of the FileNexus server.
Printer Name
The printer that the Spool Grabber program should be monitoring. All documents sent to
this printer will be sent to the FileNexus server for archival.
HINT: To make things easier for your users, you can rename your printer to something
like "FileNexus Printer" (instead of using the original name - HP LaserJet Series II).
Advanced
Click on this button to go to the Spool Grabber's Advanced Settings screen.
NOTE: In most cases the default values will be fine. The Advanced settings should only
be used if you are having trouble with the quality of the images that the Spool Grabber is
creating.
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Spool Grabber Advanced Settings

Note: Under normal circumstances you should not need to change any of these settings.
If you would like help with any of these settings, please call the support line or send an
e-mail request to support@loristech.com .
Image DPI
The number of dots per inch that the image will be stored in. For example, a value of
200 DPI means that your image will be stored with a resolution of 200 dots per inch.
Note: this value must be used in conjunction with the Image Width and Image height
values. Changing only the Image DPI value will result in incompatible settings.
Description
If the value in the description field matches a registry key on the FileNexus server (under
the spool capture service), the server can be instructed to put this document into a
specific directory. The values in the pull down list come from registry entries on the
client PC.
Use Original Size
By default this checkbox should be left empty. Placing a check in this box tells FileNexus
to use the original size of the image rather than trying to reduce the image size. The
original size of the image is determined by the resolution the FileNexus printer is set at.
If you place a checkmark in this box, values in the Image Width, Image Height and DPI
fields will be ignored.
Image Width
This is the width of the image in pixels. The default value is 1700.
Image Height
This is the height of the image in pixels. The default value is 2200.
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Setting up the Spool Capture Service

Setting up the Spool Capture Service
The Spool Capture Service runs on the FileNexus server. This program monitors one or
more directories looking for (.tif) files that have been sent to the server from a client PC
using the FileNexus Spool Grabber program. When the spool capture service detects a
new .tif file in one of its monitored directories, it will extract the text from the images
of the pages and then try to identify the document. Identified documents are turned
into .tif images with matching .nxs script files and then they are sent to another
directory to be archived (by the FileNexus Auto Archival Service). Documents that
cannot be identified are placed into an "Unknown" directory.
To set up the spool capture service, a FileNexus Administrator should connect to the
FileNexus Server and select "Spool Capture Management" by right-clicking on the
FileNexus Management icon in your Windows system tray (as shown below).

If this is the first time that you have used the spool capture management program, you'll
need to create one or more sessions. Please refer to the section Spool Capture
Management under the FileNexus Management application for more information.
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Additional Administrative Topics

Overview
As a FileNexus Administrator, there are a few topics you will need to consider to ensure
the ongoing successful employment of FileNexus for your archiving and document
retrieval needs.
Backing Up FileNexus
FileNexus Registry Keys and Settings
FileNexus and Active Directory/LDAP authentication
Event Scripts and FileNexus Workflow
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Backing Up FileNexus

Overview
As a FileNexus Administrator, you will have to ensure that your data is maintained
through regular network backups, in the event of hardware failure or loss.
What to backup
1. FileNexus SQL database(s).
For example, if you have a SQL Server 2005 database called Nexus, it is recommended
that it is backed up nightly. In addition, if you are employing Full-Text searching, you
may also want to include your Nexus_FT database in your backup plan.
2. FileNexus Archive (.far) files.
Current archive files (i.e. archive files that new data is still being added to) should be
backed up nightly. Note: Your backup software must be enabled to back-up “Open”
files.
Older files (i.e. files that have reached their maximum size and have been closed) do not
need to be backed up nightly if you have made a permanent backup copy to optical
media such as CD or DVD.
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To verify where these .far files are located at your site right-click on the FileNexus
Management icon in your system tray and select FileNexus Server Properties. Highlight
the Archive Paths item, as shown below, to view the path(s) to your .far files.

3. FileNexus Notes and Markups
Notes and markups are stored in an annotation directory. This directory should be
backed up nightly. To determine what directory annotations are being stored to at your
site select the System Paths item in the FileNexus Server Properties. The “Annotate
Directory” field will show the directory that FileNexus notes and markups are being
stored to.
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4. FileNexus Script files.
If any of your Archival, Identification (PDF, AFP, Text, Image, Email) or Pre-Processor
sessions are using external .vbs routing script files then you should back-up those script
files nightly. Typically, scripts will be stored to a C:\Program Files\FileNexus\Scripts
directory. To determine what scripts are being used on your system (if any) and what
directories they are stored in you'll need to check the session properties for each
Archival Session, Pre-Processor Session, and Identification Session. In the session's
property window you will find a field labeled something like “Routing VB Script file”. The
value in this field will show both the script file (if a script is being used) and the path
where the script file is stored. Note: Since each session can reference a different
script file and directory you'll need to check all of your sessions.
5. FileNexus Setting Files.
Typically, your FileNexus server's settings files will be in a directory similar to the path
C:\Program Files\FileNexus\Settings. These files need to be backed-up nightly.
6. Registry Settings
You should also backup the FileNexus Server's “HKEY_LOCAL_MACHINE\SOFTWARE\Loris\”
registry settings nightly.
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FileNexus Registry Keys and Settings

Overview
FileNexus creates several registry keys on the FileNexus Server when installed. This is a
brief review of some of the registry keys you may need to reference or reset to facilitate
the various features in FileNexus.
To access the FileNexus Server registry keys, type in regedit in the Windows Run dialog,
and hit OK.

Then, navigate to the folder
HKEY_LOCAL_MACHINE\SOFTWARE\Loris\FileNexus\ServerNexus.

392

Your resulting Registry Editor window should look similar to the one below.

The entries in the right-hand pane of the Registry Editor window are referred to as
Registry Keys. Each key can have a corresponding value associated with it that may be
used by one or more FileNexus applications. In order to edit the value of any of the keys,
simply double-click on the key and an edit window will appear.
AccessPassword
This is a FileNexus generated password that allows the Active-X FileNexus Connection
Control to connect to the FileNexus Server. If you modify this password, you may need to
edit any custom VB Scripts you are employing with FileNexus to reference the new
password.
Allowable
AnnotatePath
See the System Paths Tab section of the FileNexus Server Properties.
ATO
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ClietArchivePath
See the System Paths section of the FileNexus Server Properties.
CommandTimeOut
This is the amount of time, in seconds, that FileNexus will allow before any request
against the FileNexus SQL database will timeout. For example, if you are trying to
conduct a complex search to retrieve thousands of archived documents in FileNexus, the
FileNexus Client application will use this registry key to determine how long in seconds to
allow the SQL transaction to complete before timing out. If you wish to modify this
value, be sure to select decimal in the edit window before entering the number of
seconds.

ConnectionTimeOut
Represents the amount of time in seconds that the connection to FileNexus will remain
during a period of inactivity in the FileNexus Web Client.
DisableAppAuthLevel
The value of this key determines what level of DCOM authentication FileNexus will use in
order to allow communication between Client PCs and the FileNexus Server. A value of
False will mean the FileNexus Server will use its default DCOM authentication level
between the Client PC and the FileNexus Server, regardless of the connection level set on
Client PCs. A value of True will mean that the FileNexus Server will use the lowest level
of authentication on either the Client PC or the FileNexus Server.
DefaultMultiIndexSize
Refers to the default character length of a new Multi-value index being created in the
Data Capture Setup program. If you wish to modify this value, be sure to select decimal
in the edit window before entering the number of characters (string length).
DescriptionPaths
See the section on Description Paths.
DisableFNPasswords
See the section on Active Directory.
EmailAlertAddressList
Refers to the Add button feature in the Email Alerts section of the FileNexus Server
Properties.
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EmailAlertEnabled
Does not need to be set or modified in the Registry Editor. See the section on Email
Alerts.
EmailAlertFromAddress
Refers to the sender’s address for when FileNexus sends a FileNexus Administrator an
email notification as described in the section on Email Alerts.
EmailAlertHost
Does not need to be set or modified in the Registry Editor. See the section on Email
Alerts.
EmailAlertPass
Does not need to be set or modified in the Registry Editor. See the section on Email
Alerts.
EmailAlertPort
Does not need to be set or modified in the Registry Editor. See the section on Email
Alerts.
EmailAlertUserID
Does not need to be set or modified in the Registry Editor. See the section on Email
Alerts.
FileNexusCachePath
See the System Paths section of the FileNexus Server Properties.
FileNexusTempPath
See the System Paths section of the FileNexus Server Properties.
FileNotFound
The value of this key will display as an error message if the archive file (.far) that a given
document is stored within cannot be located in the Archive paths listed in the FileNexus
Server Properties.
FormOverlayPath
Refers to the paths where form overlay images are stored.
FullDomainName
See the section on Active Directory
LDAPServer
See the section on Active Directory
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MaxHitCount
This value is the maximum number of hits a user can enter when conducting a Full-Text
search in the FileNexus Client. A hit is defined as a single archived document that
contains at least one occurrence of the text being searched for. For example, if the
MaxHitCount is set to 5000, the maximum number that a user can enter in the Max Hits
text box in the below window will be 5000. If you try to enter a number greater than
5000, FileNexus will automatically adjust the number to what the MaxHitCount registry
key has defined.

Search Path
This is the directory path(s) that FileNexus uses in order to find any archive files (.far
files) when opening up archived documents in the FileNexus Client. You can
modify/add/delete directory paths to your .far files by going to the Archive Paths in the
FileNexus Server Properties dialog.
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